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INTRODUCTION 

Cabinets are the basic elements of a kitchen: they content objects, they support the sink, or they integrate 
an oven or a hood. There are four types of cabinets: base, wall, high and corner cabinet. Each type of 
cabinet can be customized to arrive to a choice of hundreds of different models for the customer. 

Thanks to this documentation, you will know how to create a sample base cabinet and be able to create 
various models from it. 

For our sample case, let’s assume that our Range contains as best-seller a classical base cabinet with a 
black wood facade, a white knob, a natural wood top, four legs and a shelf inside. That this cabinet exists 
in two widths, with three possible worktops, a left or right-opening door, and a vertical handle in option, 
all this up to the customer.   

We have to create the different parts of this cabinet, enable and define the variations, assemble the 
components to a piece of furniture matching with the real one, set the pricing, and finally add the cabinet 
to a catalog. 

 

This documentation is the first of a series of tutorials. It is also available online. 

 

Note: The aim of this step-by-step documentation is to help you create a base cabinet manually. This 
might be a long proceeding if you want to add several cabinets and their variations to the database. 

There is a way to deal with large catalogs, reduce delays and ease the global creation process by 
automating the most of it: by using the ByMe API and our libraries of 3D assets, assemblies and materials. 
Contact us for more information about this. 

PRE-REQUISITES 

To follow the complete process described hereinafter, you must have access to the applications with the 
appropriate rights. 

You also need the following: 

 Range information: Products, the corresponding 3D models, the 2D and 3D representations of 
them, a description, pricing and information about their behavior. 

 Information about the Legal Entity to which the range belongs. 

 An Application Distribution: This distribution is the way used by the platform to launch the planner 
in a certain context (e.g. for a specific language, a specific country, a specific set of catalogs). 

OVERVIEW 

The diagram below is an overview of the workflow to create a base cabinet, from the 3D assets until it is 
visible in the Company’s Kitchen Planner for the customer. 
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Figure 1 – Workflow of the creation of a base cabinet 

Although Geometry Editor, Assembly Editor, 3DCloud and the Kitchen Planner are inside the same 
solution, their user is not unique. Each ByMe application requires specific skills. 

 Geometry Editor requires Designer skills; 
 Assembly Editor requires CAD skills; 
 3DCloud, which is the front-end of the ByMe database, requires transversal skills: a Range 

manager with publishing workflow skills; 

In the case of automated processes, the dialog with the database via the ByMe API should be done by a 
developer. 

TERMINOLOGY 

 Refer to the Reference documentation of the ByMe platform for the complete list of the terms and 
concepts used in the applications. 

Below is a short list of terms used in Geometry Editor and Assembly Editor. The table is ordered from 
content to container. 

Geometry The shape of an object, represented as a mesh of triangles. 

Texture A bitmap file contributing to the definition of a material. 
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Material The representation of the visual properties of an object, such as color, shininess, 
reflexivity, etc. This representation is a BM3MAT asset. 
It can include several textures representing each of these properties. 

Linear products (worktops, cornices, strips, etc.) using materials as resources are 
generated by the application depending on the context. 

Model The combination of a geometry with one or several materials. It is stored in 
Geometry Editor as a BM3 binary asset file. 

Product The datasheet of a model in 3DCloud, which will be stored in the database with a 
unique ID. This sheet includes text descriptions, tags, an image that will be used as 
a thumbnail, a link to the BM3 or a BM3MAT or a BMA file, various parameters, etc. 

Component A building element of Assembly Editor, calling a product and its parameters. This 
component will be set to define additional or overloading parameters, and its 
positioning in the space. 

Assembly Leveraging traditional CAD notions, an Assembly is the aggregation of several 
components, specifying their relative positioning through precise parameters and 
relations. It is created and managed by Assembly Editor as a BMA asset file. 

 

Note that the names change throughout the whole process, to illustrate their state change, as illustrated 
below: 

 
Figure 2 – Name change and state change 

CONVENTION 

 
This “cabinet” icon indicates that the information relates specifically to the sample cabinet. 
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STEP 1 – MODELING  

The modeling is made in a third-party application. However, there are some recommendations about it. 

Prepare the Assets 

The first step consists in creating all the assets that will result in the base cabinet offered for sale. 

This work should be done according to the compatibility of the 3D modelling software with Geometry 
Editor, and the concordance of the software features with those of Geometry Editor. 

Note: We recommend to use Solidworks 2018 as modelling software. The interoperability with Geometry 
Editor is native using the 3DCloud Solidworks plug-in. 

The level of support provided by Geometry Editor is the intersection of three aspects: 

 Is the 3D Modelling software compatible with Geometry Editor? 

 Does the software provide an export format supported by Geometry Editor? 

 Does the software support every geometric features that are required by Geometry Editor? 

 Refer to “Appendix 3” for detailed information on these questions and make the best choice for your 
configuration. 

Create the Objects 

Create all the 3D objects needed to build a base cabinet. The final object “cabinet” is a combination of 
many 3D objects, such as a door and its handle, and of materials. 

 

For our sample base cabinet, we will need to create the following models: a box, a door front, 
a knob, a handle, a leg, and a shelf. In addition, we will create a material: the worktop. 
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STEP 2 – WORK WITH GEOMETRY EDITOR  

The second step consists in importing the 3D object files into Geometry Editor, edit them (i.e. define which 
areas will be scalable and/or act on materials among others) and then, convert them to the Geometry file 
format. 

These files are preferably in .DAE format, but it may be: 

 .GLB files; 

 A folder containing either a .BIN + a .GLTF + the required textures; 

 A folder containing an .OBJ file + one or more .MLT files + one or more textures; 

 A folder containing a .DAE file + an image folder. 

 See “Appendix 3 / Analyze the supported features” for further detail. 

Import 3D files into Geometry Editor 

To import files, proceed as follows: 

1. Connect to 3DCloud, the UI of the ByMe database. 

2. Scroll down to 3D Tools and right-click to open Geometry Editor in a new tab. 

 
3. Open Finder or the Windows Explorer to search for the .DAE file corresponding to the first model 

that you want to open in Geometry Editor. 

4. Drag and drop it to the Editor tab. The 3D representation of the model is now visible, you can 
manipulate and edit it. 

Quick Overview of the Interface 

 Refer to the “ByMe Geometry Editor Reference” documentation for detailed information on the User 
Interface. 
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Figure 3 – The Geometry Editor workspace 

The workspace is organized into four areas. 

 The scene, which is the 3D representation area where you can manipulate the model. 

 A left grey panel, where you can visualize and edit various options for the whole geometry. 

 A right black panel, where you can visualize and edit options for the selected 3D node or material. 

 A Save menu, depending on what is selected in the scene. 

The Black Panel 

 
The black panel is where you define material variations. 

Select a node on the model to expend the menu, then expend each menu item to access the options. 

Some options on the black panel have borders: options with a red border allow you to select a file; with 
green borders to enter text; with blue borders to enter numeric values. 

The content of the black panel varies depending on the type of material (Phong or PBR) that is selected 
on the scene. 

The Grey Panel 

 
The grey panel is where you define scalable areas. 

You can customize the workspace by selecting some of the settings in the General area. For example, 
check the Origin axis box to display the X, Y and Z-axis. 
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The Save Menu 

This menu offers three options: 

 Save model: Save the whole model as a .BM3 file. 

 Save selected object: Save the selected node as a .BM3 file. 

 Save selected material: Save the material (or the material of the selected node) as a .BM3MAT 
file. 

Edit 3D Models 

The ByMe platform allows the dynamic modification of models (i.e. the model displayed to the user can 
be different from the 3D model file) by a Range Manager in 3DCloud, or by the customer in the Kitchen 
Planner. 

Editing a model is essential if you want to create product variations. These variations might be to change 
the dimensions of the product or to change the material of the product. 

 

Variation Name Description 

Enable size variation Scaling Increase or decrease the size of the objet while keeping 
the ratio between the three dimensions (height, width, 
depth). 

Smart scaling Make an area be stretchable on an axis. 

Change the 
color/material 

Publication Allows defining a face (i.e. a group of triangles) by an ID to 
be able to change applied material or color on this face via 
a parameter. 

Applied material shall be in .BM3MAT format. 

Smart-Scaling 

 Refer to the “ByMe Geometry and Materials Reference” documentation for detailed information on 
scaling, especially “Preparing geometries and materials for variability”. 

It is possible to scale geometries, either uniformly on each axis (default scaling) or non-uniformly, the 
smart-scaling working independently on each axis. However, smart-scaling is incompatible with curved or 
round shapes. 

You can set a smart-scaling to allow the customer make changes in the Kitchen Planner such as enlarging 
the cabinet. 

Important: To avoid scaling artifacts, a model supporting smart-scaling must have mesh edges all along 
the limit between stretchable and non-stretchable areas. 
Meshes that have been decimated / simplified will not guarantee this property and thus, will work poorly 
with smart-scaling. 

 

For our sample cabinet, we will have to define a non-uniform scaling to allow the customer 
choose between two widths. The box, the door front and the shelf will be stretchable on the 
X-axis. 
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Material Publication 

 Refer to the “ByMe Geometry and Materials Reference” documentation for detailed information on 
preparing 3D assets to work properly and materials to remain homogeneous after publication. 

Changing a material on an object or a part of it can be triggered by a parameter value change originating 
in 3DCloud (or the API), a product rule or the product edit panel of the Kitchen Planner. 

A publication is a two-step action: 

1. In Geometry Editor: Assign a publication to editable nodes of the product. 

2. In 3DCloud: Add the matching material variation parameters. 

 
For our sample cabinet, we can define a publication for the knob and the shelf. 

Save the Files  

Saving models and materials in Geometry Editor generates the following file formats. 

BM3 The native format for 3D assets, containing a mesh of vertexes, parametric scale where 
appropriate, geometries, embedded materials and textures. 

In addition, save as models (.BM3 files) the items that do not require 3D nor variations, 
such as the legs. 

BM3MAT The native format for materials. It stores materials definition and textures, as well as ByMe 
additional concepts like UVOperators. 

 

Note: Models and materials are editable in the database through the 3DCloud User Interface. 
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Sample Cabinet 

To create our sample cabinet, you should have the following objects. 

 

Model & Material File format Sample 

A box BM3 

 

A front door BM3 

 

A handle BM3 

  

 

A leg BM3 

 

A shelf BM3 

 

A worktop BM3MAT 
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Check List before Editing 

If you want to duplicate a model to change its material or color, we highly recommend to save them as 
different models and not as a unique model with variations. For example, we will create a white knob 
from the metal one to have two knob models. 

Model & Material Scaling Description 

Box  Yes Enable scaling for further width change 

Door  Yes Enable scaling for further width change 

Knob  No Changing the material to create a second knob 

Metal Handle  No  

Leg  No  

Shelf  Yes Enable scaling for further width change 

Worktop  No Linear material 

Note: You do not have to start with a product in particular; there is no hierarchical order between the 
products in Geometry Editor. However, there is a tree structure in Assembly Editor. 

About the Axes 

Geometry Editor offers a 3-dimensional view of the model. Scaling will be made on these axes. 

You can display the axis on the scene by selecting the Origin axis check box in the General area. 

Important: The origin point has been defined when creating the 3D object. In our sample, object are 
centered on the origin point. This will be important in Assembly Editor, when defining the positions of the 
different components. 

 

 
Figure 4 – The X, Y and Z-axes 
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Figure 5 – Axial positioning of an object in Geometry Editor 

Note: Select the Back plan option to be sure that the model is well located in the space. 

About the Dimensions 

The General area on the left panel gives essential information about the object:  

 Triangles: The number of meshes of the 3D object. 

 Size: The dimensions of the object, according to its positioning on the axes. 

Value 600 600 800 

 

Dimension Width Depth Height 

Axis X Y Z 

 

 For performance reasons, the ByMe platform encourages low poly assets. Refer to the “Geometry and 
Materials Reference” documentation for detailed information on “Large Models, LOD and Simplification”. 

About the Ratio 

The Scale fields, used to stretch a whole axis and not a part of it, are expressed as a ratio. By default, the 
Smart Scale fields are expressed as a ratio too. 
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The ratio is calculated from the actual size of the object, which is “1”. Therefore, to double a dimension 
on an axis, enter 2; to reduce by a half, enter 0.5. 

When defining a Smart Scaling area, choose to work with millimeter values by switching the white Ratio 
cursor to the right. 

About the Scalable Areas 

When you stretch uniformly a whole object, the stretch area includes the side panels in the case of a box, 
or the molding in the case of a door. 

To keep the size of these parts, you have to define scalable areas. This will define non-scalable areas by 
exclusion. 

 

This illustration shows a basic cabinet with top-holes to 
fix the worktop on it and back-holes to fix the cabinet 
to the wall. The scalable area should exclude: 

 The left and right panels of the box 
 The top and the back-holes 

The illustration shows in yellow the area that should be 
defined as scalable. Outside this yellow area, all will be 
excluded from the scaling. 

This means that you only have to enter the start and 
end positions of the scalable area. 

Move the object on the scene to be sure to locate all 
the parts to exclude. 

Important: Define the positions of the scalable area carefully to ensure the behavior in Assembly Editor. 

Edit the Box to Define Scaling 

Our work on the box is to define scaling to allow the widening of the box, which default size is 60 cm, to 
80 cm. 

Important: The box will not be stretched uniformly (this would increase or reduce the whole box including 
the side panels among others) but on the X-axis only and inside the concerned area to keep the thickness 
of the panels. That is why the dimensions will be set in the Smart Scale area. 

To define the scaling, proceed as follows: 

1. Scroll down in the left panel to the Smart Scale area. 

2. Choose to express the dimensions in millimeters. By default, the fields are specified with the 
dimensions of the box. 

3. Click the View button to display the scalable area in yellow. By default, the whole box is included 
in the area. 
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Now you have a choice between entering the values manually and using the mouse. 

Enter the Values Manually 

If you already know the values, enter them in the X input fields. The area should exclude the side panels, 
the holes on the top and the holes on the back. For our example: 

1. Enter 71 in the Start field. This is where our scalable area starts on the X-axis. 

2. Enter 534 in the End field. This is where our scalable area ends on the X-axis. 

Click to Define the Values 

If you do not already know the values, you can define them by clicking them on the scene. 

1. Use the mouse wheel to zoom in the object on the scene. 

2. Click the Edit icon on the right. This opens a Pick up area. 

 
3. Click with the left button of the mouse where you want the scalable area to start. 

4. Click with the right button where you want the scalable area to finish. 

 
5. Click Cancel to exit from the pick-up area. The new values are taken into account. 

Note: Using the mouse to define the area can be very precise: the exact position in millimeters is displayed 
while moving the mouse. 

However, it is recommended to adjust values by rounded, symmetric and coherent numbers. 
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In the case you want to define several scalable areas on an axis, you have to add lines to the X area by 
clicking Create a new area. 

 

Test the Scaling 

You can test the scaling by clicking Test Smart Scale on the bottom of the grey panel. 

Go to Scale and enter a value in the X field, e.g. 1.5 to stretch to 50% more, or use the arrows to increment 
the value. 

Save the Changes 

Click Save model to save the box and its scaling parameters as a BM3 file. 

Note: The variation from 60 cm to 80 cm will be defined in 3DCloud. 

Edit the Door Front to Define Scaling 

Our work on the door front is to define scaling to enable a width variation of the central panel on the X-
axis, excluding de facto the frame and the moldings. 

The dimensions of our sample door are width 598 / depth 20 / height 798 mm. 

To define the smart scaling, proceed as follows: 

1. Scroll down in the left panel to the Smart Scale area. 

2. Choose to express the dimensions in millimeters and click the Eye 
icon. By default, the whole surface will be in the area. 

3. Click the Edit button to pick up the values to reduce this area. 

4. Zoom in and click left to define the start value along the left molding. 
In our case, the value is 94. 

5. Click right to define the end value along the right molding. In our case, 
the value is 305. 

6. Click Cancel to exit from the pick-up area. The new values are taken 
into account. 

7. Test the smart scaling if you want.  

Save the Changes 

Click Save model to save the door and its scaling parameters as a BM3 file. 

Edit the Knob to Create a Duplicate 

You may want to create a variation of a model, e.g. the same knob with another material and another 
color. The knob is made of two nodes (the nodes are defined during the modeling) and we will make a 
publication on the node corresponding to the button. 
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To create a duplicate of the metal knob, proceed as follows: 

1. Click the button on the scene to select it as Node3D. 

2. Specify a name if you want (press Enter to validate). 

3. Go to Materials & Publications. 

4. Click Load material to open the Finder or the Windows Explorer and search for the BM3MAT file 
corresponding to the new material. For example, a white acrylic material file. 

5. Click Open to load the file and add it to the list of choices named Scene materials. 

6. Rename the material if need be by specifying the Name field in the PhongMaterial area (press 
Enter to validate). 

The Scene material drop-down list now contain a White Acrylic variation: 

 
If you want to change the material of the ring, select the corresponding node and then proceed as for the 
button. 

Save the Changes 

Click Save the model to save the changed knob and its parameters as a .BM3 file. 

Now, you have two different knobs at disposal. 

Edit the Handle to Save it as Model 

There is no scaling or publication work to do in Geometry Editor with the metal handle. 

But you have to save it as a .BM3 file in order to import it in 3DCloud at the next step. Click Save model. 

 

Edit the Shelf to Define Scaling 

The work on the shelf is to enable the scaling on the X-axis, as for the box and the door. In addition, you 
might want to change its color. 
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Because there are no areas to exclude for the shelf, you can define a simple scaling. 

1. Scroll down in the left panel to Scale. 

2. Specify the X field with a ratio of 1.33 to stretch the shelf to 33% more on the X-axis. 

 

Note: You can change the color of the shelf only if the model is a .SVG file or if the material has no texture. 
Else, change the material (see above the proceeding with the knob). 

 

To change the color, proceed as follows: 

1. Select the object on the scene, to select the node on the black panel. 

2. Scroll down to PhongMaterial. 

3. Roll over the Diffuse color field to display a color palette. 

4. Pick up the wished color. 

5. Change the Specular color in addition if need be. 

Save the Changes 

Click Save the model to save the shelf and its parameters as a .BM3 file. 

Edit the Worktop 

The worktop is a linear material, i.e. a .BM3MAT file. As a linear, it is stretchable by definition and there 
is no scaling to define. 

The substitution of one worktop by another will be set in 3DCloud. 

You might want to change the tiling operator. In this case, scroll down the black panel to UVOperator and 
change the ScaleX and ScaleY values to adapt them to your needs. The tiling is expressed in millimeters. 

Save the Changes 

Click Save selected material to save the worktop as a .BM3MAT file. 

Save the Leg as BM3 

There is no edition work to do on the legs, but it need to be converted into a .BM3 file to be used as 
product and then component in 3DCloud and Assembly Editor. 

Drag and drop the leg 3D model in Geometry Editor and then, click Save as model. 
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STEP 3 – CREATE PRODUCT DATASHEETS  

 For detailed information on the 3DCloud user interface, see the “3DCloud” documentation. 

The next step consists in creating in 3DCloud one datasheet per model (.BM3 file). Once the datasheet is 
created, the model becomes a product. 

Each datasheet will define the name of the product and the descriptions to display in the Kitchen Planner 
(both in various languages); link the model to a type and a brand; define its period of availability and its 
pricing; define various tags to reference it; contain a 2D and a 3D representation if need be; contain size 
parameters and options if need be. 

Important: This step is mandatory to make the products available in Assembly Editor, including the articles 
that have not been edited in Geometry Editor, such as the legs. 

Create Product Datasheets 

To create a product datasheet, proceed as follows: 

1. Open 3DCloud and go to Content / Products. 

2. Click New product in the Products tab. 

At this step, the database automatically assigns an ID to the 
product. To choose the ID of the product, you have to use the API.  

 

 

For our sample cabinet, you have to create datasheets for each product (box, door front, 
handle, shelf and the legs). As best practice, do not create any material datasheet, because 
materials should have been applied in the .BM3 3D model. 

About the Language 

The possible languages are defined in the application distribution. The languages available for the name 
field and the Commercial information drop-down list depend on these settings.  

About the Product Types 

Selecting a product type is mandatory because it will trigger the applicative rules. 

If you hesitate between several similar types, use the type that describes the destination of your product. 
For example: if you have a choice between several types of doors, do not use “doors” but specify that the 
door is the front of the cabinet and select “front doors”. 

 See Configuration Guide / Predefined Applicative Rules in the Reference documentation. 

About Descriptions 

Although the description fields are not mandatory, they are highly recommended. 

The commercial description and the short description will be displayed to the customer in the product 
page of the Kitchen Planner. 
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You can write as many words as wished in the Commercial description area. If the text exceed the text 
area, a scroll bar will appear. 

However, the number of words is limited in the Short description text area. A best practice is to limit the 
short description to five words (keep in mind that description will be translated). 

About Tags 

Tags are not mandatory for Kitchen, because they are not used as filters in the Kitchen Planner. However, 
you can specify that your product is intended for the “kitchen” room. 

About Parameter and IDs 

You will have to define parameters in the datasheets and give them an ID. 

They make the link between the 3D representation (the .BMA file) and the product containing this 3D 
representation. The mapping is done by creating parameters using the same name (case sensitive) in 
3DCloud and in Assembly Editor. 

Parameters are defined at three levels: 

1. At “simple product level”, when products do not belong to an assembly yet. 

2. At “sub-assembly level”, when the product are combined in a sub-assembly. 

3. At “top-assembly level”, when products and sub-assemblies are grouped together into a final 
assembly. 

Important: The size parameters (width, depth, height) are mandatory at each level. 

Simple Product Level Parameters 

You will define size parameters for all the products, referring to the dimensions of the 3D model. 

Select dimension variations to define the fixed or variable width, height and depth for each product. 

Additionally, you have to define ‘type’ options for the fronts and handles. 

 

For our sample cabinet, you will define at this step the parameters of the first level, that is to 
say the dimensions of the box, the door front, the handles, the shelf and the legs. In addition, 
the options of the door front and the handles. 

Sub-Assembly Parameters 

It is a best practice to create product combinations, such as “door front and handle” and “box and legs”. 
These combinations are named sub-assemblies. 

 See below “Step 5 – Datamodel” for detailed information. 

These sub-assemblies require specific parameters (i.e. options) to define their behavior. 

Top-Assembly Parameters 

Once all the products and sub-assemblies are grouped together into a single product in Assembly Editor, 
the result is named “top-assembly” and must have its own product datasheet with new parameters. 

Among these parameters, you will define options to enable the worktop in the Kitchen Planner. 

 See below “Step 6 – Save the Cabinet as Product”. 
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Writing Parameter IDs 

Below are some rules and recommendations regarding these IDs. 

 IDs are case sensitive. 

 Respect the camel case convention: capitalize the first letter of the second and following words. 
E.g. backLegPosition. 

 Never use these characters: *, \, /, @, &, {,  }, [, ], %, £, $. 

 Never use vowels with accents or umlauts. 

 Use generic words. 

 To ensure that the desired behavior will happen, the parameter needs to have the same ID as the 
BM3 material publication or BMA material parameter. The same for the width, depth, height 
parameters of the BM3. 

  In some cases, they should match expected parameter IDs in the application (e.g. worktopOption) 
as defined in the parameter dictionary. 

 Refer to the “Parameter Dictionary” for detailed information on parameters. 

About Pricing 

Pricing depends on your catalog. For some catalogs, the pricing is specified for each single product, and 
so the price of the cabinet is the sum of each products, for others it is defined at the top-assembly level 
for each combination of the cabinet. In your case, you have to choose. 

 

For our sample cabinet, we will define the pricing at the top-assembly level. Leave these fields 
blank during this step.  

Datasheet Information Overview 

Below is an overview of the information that should be specified, depending on the level. 

Note: Current Step 3 only deals with single products. Else, see Step 5 and Step 6. 
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Figure 6 – Datasheets parameters and options 

Create the Box Datasheet 

To create the datasheet for the box, follow the steps illustrated below. 

General Information 

 
1. Enter the name of the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. Note that this name will be displayed to the customer. 

2. Enter your reference for the product. This reference may be displayed to the customer and is used 
in Assembly Editor as well. 

3. Link the product to a product type, i.e. Boxes because it is a box. 

4. Link the product to your Brand. 
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Product Information 

 
1. Define the period of availability, if need be. Note that these dates always overwrite the dates set 

in the catalog. 

2. Choose a language to use in the Kitchen Planner. 

3. Enter the commercial description and a short description of the box. 

Product Representation 

The Product Representation tab is essential when creating the datasheet, because: 

 It is where you upload the model, i.e. the .BM3 file; 

 It is where you set up variations, options and mapping parameters. 

3D and 2D Representations 

 
1. Add the BM3 file by clicking Upload a 3D model. 

2. Add a bitmap picture of the box by clicking Upload a picture. It will be used as thumbnail in the 
product list in 3DCloud and in the Kitchen Planner. 
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Technical Information 

Not applicable. 

Variable Dimension 

We have defined a smart scaling on our box to enable its widening in the Kitchen Planner. Thus, specify 
the dimensions by clicking Add variable dimension. 

 
1. Select width in the ID drop-down list (or create it if need be). 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete length (mm) in the Type list. This will allow the customer to choose between 
different possible values, while the Continuous length would allow the customer to enter a value 
between two limits. 

4. Enter the possible values in the corresponding fields, with a name to display to the customer. For 
our box, enter 600 and 800. 

5. Specify the default value, i.e. 600. 

6. Click Validate to save the variation. 

The dimension variation is now defined and visible in the Variations area. 

 

Fixed Dimensions 

Repeat the proceeding to specify the height and the depth of the box. 
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Now the box datasheet contain the following variations. 

 

Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

 
When the product is successfully added (a delay is possible), the 3D model column displays Yes in the 
product list. 

 

Create the Door Front Datasheet 

To create the datasheet for the door front, follow the steps illustrated below. 
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General Information 

 
1. Enter the name of the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. Note that this name will be displayed to the customer. 

2. Enter your reference for the product. This reference may be displayed to the customer and is used 
in Assembly Editor as well. 

3. Link the product to a product type, i.e. Front doors because it is a front for the door of the future 
base cabinet. 

4. Link the product to your Brand. 

Product Information 

1. Define the period of availability, if need be. Note that these dates always overwrite the dates set 
in the catalog. 

2. Choose a language to use in the Kitchen Planner. 

3. Enter the commercial description and a short description of the door. 

4. Define tags to ease the classification of the door in the Kitchen Planner. 

 

Product Representation 

Start by adding the 3D and 2D representations of the product. 
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1. Add the .BM3 file by clicking Upload a 3D model. 

2. Add a bitmap picture of the door by clicking Upload a picture. It will be used as thumbnail in the 
product list in 3DCloud and in the Kitchen Planner. 

Variable Dimension 

We defined a smart scaling on our door to enable its widening in the Kitchen Planner. Thus, specify the 
dimensions by clicking Add variable dimension. 

 
1. Select width in the ID drop-down list (or create it if need be). 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete length (mm) in the Type list. This will allow the customer to choose between 
different possible values, while the Continuous length would allow the customer to enter a value. 

4. Enter the possible values in the corresponding fields, with a name to display to the customer. For 
our box, enter 598 and 798. 

5. Specify the default value, i.e. 598. 

6. Click Validate. 

Fixed Dimensions 

Specify the height and the depth of the box by clicking Add variable dimension (even if the dimension will 
not be variable). 

1. Select height in the ID drop-down list (or create it if need be). 
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2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete length (mm) in the Type list. This will allow you to enter a value. 

4. Enter the possible values in the corresponding fields, with a name to display to the customer. 

5. Specify the default value. 

6. Click Validate. 

7. Repeat the proceeding to specify the depth. 

Now the door datasheet contains the following variations. 

 

Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

When the product is successfully added (a delay is possible), the 3D model column displays Yes in the 
product list. 

 

Create the Knob Datasheet 

To create the datasheet for the knob, follow the steps illustrated below. 

General Information 

 
1. Enter the name of the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. Note that this name will be displayed to the customer. 
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2. Enter your reference for the product. This reference may be displayed to the customer and is used 
in Assembly Editor as well. 

3. Link the product to a product type, i.e. Handles because a knob is a type of handle. 

4. Link the product to your Brand. 

Product Information 

1. Define the period of availability, if need be. Note that these dates always overwrite the dates set 
in the catalog. 

2. Choose a language to use in the Kitchen Planner. 

3. Enter the commercial description and a short description of the knob. 

4. Define tags to ease the classification of the knob in the Kitchen Planner. 

 

Product Representation 

Start by adding the 3D and 2D representations of the product. 

 
1. Add the BM3 file by clicking Upload a 3D model. 

2. Add a bitmap picture of the knob by clicking Upload a picture. It will be used as thumbnail in the 
product list in 3DCloud and in the Kitchen Planner. 
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Type Option 

These variation parameters will complete the publication made in Geometry Editor. 

 See Appendix 2 for the list of possible parameters for a base cabinet. 

Handles can be of three different types: 

 Type 1: A classic handle, to fix on the front door 

 Type 2: An edge handle, to fix on the edge of the door 

 Type 3: A drop handle 

This type parameter is mandatory, unless you will not be able to place the knob on the door front. 

Click Add option. 

 
1. Click Create new to specify type as the ID. Click the + to add it to the ID field. 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete variation in the Type list. This will allow you to enter a value. 

4. Enter 1 and Classic as unique possible value. 

5. Specify the default value, i.e. 1. 

6. Click Validate. 

Fixed Dimensions 

Define the dimensions of the handle by clicking Add variable variations. This variation is used for any 
dimension specification, even if it will not vary. 
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7. Select width in the ID drop-down list (or create it if need be). 

8. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

9. Select Discrete length (mm) in the Type list. This will allow you to enter a value. 

10. Enter the size in the Possible values fields. 

11. Specify the default value, i.e. 30. 

12. Click Validate. 

13. Repeat the proceeding to set the height and depth parameters with the same dimension. 

 

Material Replacement 

Important: You will define a material replacement in the datasheet only if it has not been defined in the 
BM3 model itself in Geometry Editor and on condition that the other material has a material datasheet. 

As a best practice, we duplicated the knob in two models after a material publication in Geometry Editor. 
That is why a material replacement is not required in 3DCloud. 

Product Replacement 

Important: Product replacement is only used on sub-assemblies, or top-assemblies. 

To allow the customer to choose between our three possible handles (two versions of the knob and the 
metal handle), we will define a product replacement in the datasheet “front and handle” sub-assembly. 

 See “Step 5 / Save the Front and Handle Sub-Assembly”. 
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Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

When the product is successfully added (a delay is possible), the 3D model column displays Yes in the 
product list. 

 

Create the Metal Handle Datasheet 

To create the datasheet for the metal handle, follow the steps illustrated below. 

General Information 

 
1. Enter the name of the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. Note that this name will be displayed to the customer. 

2. Enter your reference for the product. This reference may be displayed to the customer and is used 
in Assembly Editor as well. 

3. Link the product to a product type. 

4. Link the product to your Brand. 
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Product Information 

 
1. Define the period of availability, if need be. Note that these dates always overwrite the dates set 

in the catalog. 

2. Choose a language to use in the Kitchen Planner. 

3. Enter the commercial description and a short description of the handle. 

4. Define tags to ease the classification of the handle in the Kitchen Planner. 

Product Representation 

Start by adding the 3D and 2D representations of the product. 

 
1. Add the BM3 file by clicking Upload a 3D model. 

2. Add a bitmap picture of the handle by clicking Upload a picture. It will be used as thumbnail in 
the product list in 3DCloud and in the Kitchen Planner. 

Type Option 

These variation parameters will complete the publication made in Geometry Editor. 

 See Appendix 2 for the list of possible parameters for a base cabinet. 
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Handles can be of three different types: 

 Type 1: A classic handle, to fix on the front door 

 Type 2: An edge handle, to fix on the edge of the door 

 Type 3: A drop handle 

This type parameter is mandatory, unless you will not be able to place the handle on the door front. 

Click Add option. 

 
1. Click Create new to specify type as the ID. Click the + to add it to the ID field. 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete variation in the Type list. This will allow you to enter a value. 

4. Enter 1 and Classic as unique possible value. 

5. Specify the default value, i.e. 1. 

6. Click Validate. 

Fixed Dimensions 

Define the dimensions of the handle by clicking Add variable variations. This variation is used for any 
dimension specification, even if it will not vary. 

 
1. Select width in the ID drop-down list (or create it if need be). 



CREATE A BASE CABINET Tutorial Step 3 – Create Product Datasheets  

3DVIA Documentation February 2020 - 38 - 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete length (mm) in the Type list. This will allow you to enter a value. 

4. Enter the size in the Possible values fields. 

5. Specify the default value, i.e. 30. 

6. Click Validate. 

7. Repeat the proceeding to set the height and depth parameters with the same dimension. 

Now the Variations area contains the following: 

 

Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

When the product is successfully added (a delay is possible), the 3D model column displays Yes in the 
product list. 

 

Create the Shelf Datasheet 

To create the datasheet for the shelf, follow the steps illustrated below. 
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General Information 

 
1. Enter the name of the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. Note that this name will be displayed to the customer. 

2. Enter your reference for the product. This reference may be displayed to the customer and is used 
in Assembly Editor as well. 

3. Link the product to a product type, i.e. Cabinet shelfves because this shelf belongs to a cabinet. 

4. Link the product to your Brand. 

Product Information 

 
1. Define the period of availability, if need be. Note that these dates always overwrite the dates set 

in the catalog. 

2. Choose a language to use in the Kitchen Planner. 

3. Enter the commercial description and a short description of the box. 

4. Define tags to ease the classification of the box in the Kitchen Planner. 

Product Representation 

Start by adding the 3D and 2D representations of the product. 
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1. Add the BM3 file by clicking Upload a 3D model. 

2. Add a bitmap picture of the box by clicking Upload a picture. It will be used as thumbnail in the 
product list in 3DCloud and in the Kitchen Planner. 

Variable Dimension 

We defined a smart scaling on our shelf to enable its widening in the Kitchen Planner. Thus, specify the 
dimensions by clicking Add variable dimension. 

 
1. Select width in the ID drop-down list (or create it if need be). 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete length (mm) in the Type list. This will allow the customer to choose between 
different possible values, while the Continuous length would allow the customer to enter a value. 

4. Enter the possible values in the corresponding fields, with a name to display to the customer. For 
our box, enter 574 and 774. 

5. Specify the default value, i.e. 574. 

6. Click Validate to save the variation. 

The dimension variation is now defined and visible in the Variations area. 
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Fixed Dimensions 

Repeat the proceeding to specify the height and the depth of the box with only one possible value. 

Now the Variations area contains the following: 

 

Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

When the product is successfully added, the 3D model column displays Yes in the product list. 

 

Create the Leg Datasheet 

To create the datasheet for the leg, follow the steps illustrated below. 

General Information 

 
1. Enter the name of the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. Note that this name will be displayed to the customer. 

2. Enter your reference for the product. This reference may be displayed to the customer and is used 
in Assembly Editor as well. 

3. Link the product to a product type. 

4. Link the product to your Brand. 



CREATE A BASE CABINET Tutorial Step 3 – Create Product Datasheets  

3DVIA Documentation February 2020 - 42 - 

Product Information 

 
1. Define the period of availability, if need be. Note that these dates always overwrite the dates set 

in the catalog. 

2. Choose a language to use in the Kitchen Planner. 

3. Enter the commercial description and a short description of the leg. 

Product Representation 

 
1. Add the BM3 file by clicking Upload a 3D model. 

2. Add a bitmap picture of the handle by clicking Upload a picture. It will be used as thumbnail in 
the product list in 3DCloud and in the Kitchen Planner. 

Variable Dimension 

Click Add variable dimension to allow the customer change the height of the leg in the Kitchen Planner. 
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1. Select height in the ID drop-down list (or create it if need be). 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Continuous length (mm) in the Type list. This will allow the customer to enter a value. 

4. Enter the possible values in the corresponding fields, with a name to display to the customer. The 
value in the center is specified automatically with the height object.  

5. Specify the default value, i.e. 80. 

6. Click Validate. 

Fixed Dimensions 

Define the other dimensions of the leg by clicking Add variable variations again. This variation is used for 
any dimension specification, even if it will not vary. 

  

Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

When the product is successfully added (a delay is possible), the 3D model column displays Yes in the 
product list. 
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Create the Worktop Material Datasheet 

The worktop is a material (a .BM3MAT file) and needs to be recorded in a material datasheet. 

The proceeding is similar to the creation of products with few information to specify. 

Click Materials in the Content menu and then, click 
New material. 

 
1. Enter a name for the material. 

2. Link the material to a brand. This is mandatory. 

3. Specify a Materials tag. 

 

 

Click Material representation to add the 3D model and the picture that will be used as thumbnail. 
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Click Save to save the material datasheet. 

Note: Create as many worktop materials as the number of worktop products. Afterwards, create the 
corresponding product datasheets. 

Create the Worktop Datasheet 

Worktops are generated dynamically in the Kitchen Planner from the worktop products available in the 
database, and from the settings made in 3DCloud and Assembly. 

At this stage, you have to create several worktop products to create a choice of worktops for the 
customer. 

 See “Step 5 / Prepare the Worktop” and “Step 6 / Worktop Option and Worktop Type” for detailed 
information about the worktop settings. 

General Information 

 
1. Enter the name of the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. Note that this name will be displayed to the customer. 

2. Enter your reference for the product. This reference may be displayed to the customer and is used 
in Assembly Editor as well. 

3. Link the product to a product type, i.e. Worktops because it is a worktop. 

4. Link the product to your Brand. 

Product Information 

 
1. Define the period of availability, if need be. Note that these dates always overwrite the dates set 

in the catalog. 

2. Choose a language to use in the Kitchen Planner. 
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3. Enter the commercial description and a short description of the worktop. 

Product Representation 

 
1. Add the BM3MAT file by clicking Upload a 3D model. 

2. Add a bitmap picture of the worktop by clicking Upload a picture. It will be used as thumbnail in 
the product list in 3DCloud and in the Kitchen Planner. 

Fixed Dimensions 

Click Add variable dimension to define the depth of the worktop. Our worktop is a precut one, and only 
the width of our sample worktop is stretchable to be consistent with the stretching of the cabinet. 

 
1. Select depth in the ID drop-down list (or create it if need be). 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Discrete length (mm) in the Type list. This will allow you to enter the dimension. 

4. Enter 65 and Depth as unique possible value. 

5. Enter 65 as default value. 

6. Click Validate to add the dimension. 
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7. Repeat the proceeding to add the height (40 mm) of the worktop. 

Variable Dimension 

Now click Add variable dimension to define the width. 

 
1. Select width in the ID drop-down list (or create it if need be). 

2. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

3. Select Continuous length (mm) in the Type list. This allows you to enter a range of possible values. 

4. Enter 65 as default value. 

5. Click Validate to add the dimension variation. 

Now the Variations area shows the following: 

 

worktopType 

This option will determine whether the worktop is sold with predefined dimensions (“precut”), or at the 
meter (“custom”). Click Add option. 
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1. Check the Visible and Editable options to make the worktop editable by the customer in the 

Kitchen Planner. 

2. Click Create new to specify worktopType as the ID and click + to move it to the ID field. 

3. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

4. Select Discrete variation in the Type drop-down list. This will allow you to enter a value. 

5. Enter precut and Precut as unique possible value. 

6. Specify the default value, i.e. precut for our sample worktop which width will be variable. 

7. Click Validate to add the option. 

Pricing 

Worktops require a pricing mapping, which is not defined in this datasheet. 

 Refer to the “Content Publisher Guide / Pricing” for detailed information about the pricing. 

Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

When the product is successfully added (a delay is possible), the 3D model column displays Yes in the 
product list. 
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STEP 4 – ADD THE PRODUCTS TO A CATALOG  

When the product datasheets are created, you have to link them to a catalog unless they will not appear 
in Assembly Editor. 

This means that you can add as components in Assembly Editor only the products that are registered in 
catalogs. 

Product catalogs are a required link between a product and the Kitchen Planner. This catalog must belong 
to an application distribution to be visible in the Kitchen Planner. Below is an illustration of these 
relationships. 

 
Figure 7 – Product and catalog relationship 

 

We will create a unique catalog to contain all the products of our sample cabinet. However, 
the best practice is to add only top-assemblies to the catalog. 

  
 

Click the Products catalogs tab and then, New catalog to start the proceeding. 

 

General Information 

 See “Core Platform Concepts” in the Reference documentation for a definition of “Application 
distribution”. 
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1. Give a name to the catalog. This is an internal name; it will not be displayed to the customer. 

2. Select at least one Application distribution. 

3. Specify the period of viability of the catalog. Note that product dates overwrite catalog dates. 

Catalog Information 

Products are added to the catalog from this page. Even if the catalog is created, product cannot be linked 
to a catalog from the product pages. 

Click Add products to select the products to link to the catalog. You can add several products at a time. 

 
For our sample cabinet, select all the products created at step 4. 

 
Click Validate to add the product to the catalog. They are now listed in a table in the Catalog information 
area. 
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To remove a product from the catalog, select the corresponding check box and then, click Remove from 
catalog. 

Save 

Click Save to upload the catalog and its content in the 3DCloud storage. Click Products and then, Products 
catalogs to see the new product in the list (a delay is possible). 
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STEP 5 – ASSEMBLE THE PRODUCTS INTO A CABINET  

The aim of Assembly Editor is to group together the components (3D products and non-3D items, with 
their parameters) into one finished product that can be displayed to the customer, while taking their 
relative placement and orientation into account. This finished product will be offered to the customer in 
the Kitchen Planner with a 3D experience that will allow her/him to manipulate the product, zoom in and 
out, try various combinations, and eventually edit the product to match it to her/his wishes. 

The native format of Assembly Editor is .BMA. A .BMA file is a list of components that are placed according 
to a position mapping. 

Assembly Editor also allows you to add kinematics (such as opening a door in the Kitchen Planner), manage 
component positioning (absolute or relative), manage component publication, manage output sets (for 
cut-out or worktop generation) and manage anchor points (possible positions of components in editable 
furniture). 

Note: Assembly Editor allows you to work with .BM3 and .BMA files. The condition is that they have a 
datasheet in 3DCloud. 

Vocabulary and Concepts 

The aggregation of the components is named “assembly” hereinafter. 

“Components” are products registered in 3DCloud. 

The properties of each component (position, orientation, own parameters, etc.) can be linked (or 
"binded") to parameters and/or relations of the assembly: that is why these assemblies are named 
“parametric assemblies”. 

About Parameters 

There are many parameters in Assembly Editor: they are the duplication of all the parameters defined in 
the 3DCloud datasheets. There are component parameters, size parameters, material parameters, etc. 
each parameter having a different type. A parameter can be a dimension (mm), a Boolean, an integer, a 
material, or a component. 

Some parameters may be visible or editable by the customer in the Kitchen Planner, or by the Range 
Manager in 3DCloud.  

About Relations 

The default dimensions, for example, are recovered from the .BM3 file. They can be overloaded by 
dynamic values obtained through relations. 

A relation make it possible to define calculated positioning of components – instead of fixed, absolute 
positioning. For example, legs are always positioned under the cabinet with the given offset; the relation 
can determine the position of the legs, whatever the width of the cabinet is. 

Relations are expressions used to calculate dynamic values from parameters or other relations. A relation 
supports mathematic operators (such as +, - and *) or logical tests (using a dot as separator). The result 
can be assigned to component properties, output set properties and anchor point properties. Relations 
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are defined internally and cannot be overloaded, whether in 3DCloud by a Range Manager or in the 
Kitchen Planner by a user, to avoid structure problems. 

 Refer to the “Product and Assembly reference” documentation, section “Assemblies” for detailed 
information on the relations. 

 

For our sample, we will define many relations to position the legs, the handle or the door 
front dynamically.  

About Component Positioning 

The positioning of the components can be of three types: 

 Absolute, relating to the axes; 

 Relative, via expressions. 

 

 Refer to the “Assembly Editor Reference” documentation for a complete information on anchor points. 

About Kinematics 

You can define in Assembly Editor the kinematics that can be played in the Kitchen Planner. These 
kinematics behaviors are either of rotation or of translation type. 

Important: The scope of the animation cannot be on a single component of the assembly to which you 
want to add a kinematics, because it will apply on all the components. Therefore, you have to create the 
kinematics on the right level. 

 

In our case, we want the door (i.e. front with the fixed handle) to rotate: we will put the 
kinematics on the sub-assembly containing the two components front and handle. 

About Output Sets 

An output set is a linear information required in specific cases to handle application features requiring 2D 
as an input. Specific cases are every linear products: worktop, plinths, cornices… 

 
For our sample, we will define output sets to place the worktop on the base cabinet.  

 

 Refer to the “Assembly Editor Reference” documentation for a complete information on output sets. 

About Sub- and Top-Assemblies 

Sub-assemblies are a way to ease the work and make common configurations reusable. Each sub-
assembly is then registered as a product and linked to a catalog in 3DCloud in order to be used either as 
such or as a component in a top-assembly. 

For example, it is highly recommended to create a “legs and box” sub-assembly or a “front and handle” 
sub-assembly. 

A top-assembly is the final assembly built from simple components and sub-assembly components. The 
top-assembly is then registered as a product and linked to a catalog in 3DCloud. 
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Data Model 

Below is an overview of the data model, where components are grouped into sub-assemblies before 
creating the final assembly. 

We recommend creating sub-assemblies of the door front with the handle, and of the box with the legs. 
Then, add them to the top-assembly. 

 
Figure 8 – Assembly and sub-assemblies 

Quick Overview of the Interface 

 Refer to the “Assembly Editor Reference” documentation for detailed information on the User 
Interface. 
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The workspace is organized into three areas. 

 The File menu, from where you can create, open and save an assembly. 

 The Edit menu, where you create the components, parameters, relations etc. for the assembly. 

 The Scene, where you can view and manipulate the assembly. 

 The Help center, which checks the validity of the assembly. 

The File menu contain the following functions: 

 
New assembly Click this icon to create a new assembly. 

This will close the current assembly, if applicable. 

 
Open from disk Click this icon to open an assembly from your disk. 

This will close the current assembly, if applicable. 

 
Open from URL Click this icon to open an assembly from an URL. 

This will close the current assembly, if applicable. 

 
Save Click this icon to save the current assembly, even if it is not finished. 

This will create a zip file containing a root.BMA file, to save on your disk. 

Create the “Box and Legs” Sub-Assembly 

When starting a new assembly, the left menu is empty, as illustrated. 
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Add the Components 

Click Create new component on this menu, or click Add a component on the scene. 

 

 
Browse the catalog by specifying the name of the product in the search field. Use either the complete 
name as defined in the 3DCloud datasheet or the type e.g. “box” or “front”. If you want to enter only the 
first letters of the name, add an asterisk to the name*. For example: “white_*”. 

Press Enter to start the search. 

Important: If you do not find your product, check that it is linked to the catalog. 

 
 

Click the thumbnail of the product to add it to the list of components and display it on the scene. 
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Repeat the proceeding to add the leg. 

You can show or hide a component on the scene by clicking the eye icon next 
to the component name. 

 
Note that all the components are centered by default on the origin of the axes. Their final position is not 
yet defined. 

 

Duplicate the leg three times by clicking the Duplicate icon, to 
obtain a set of four legs. At this stage, they receive a default 
name. 
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Rename the Components 

Select a component in the list or on the scene to display its properties. 

This area allows you among others to rename the component and define its position. 

 
Rename the box component into “Box”. 

Important: Always capitalize the first letters of the words in a compound name to avoid confusion with 
parameter names. For example, a component name would be “CoverPanel” and a parameter name would 
be “coverPanel”. 

Rename each leg according to the diagram below: 

 
Figure 9 – Rename the legs 
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Check that the components of the “box and legs” sub-assembly are all 
renamed. 

 
 

Create Parameters 

We highly recommend that you create parameters as things progress; avoid creating all possible 
parameters “once for all” to prevent confusions. 

Create the Component Parameters 

Important: Use camel case convention when renaming the parameters. Try to create meaningful names, 
as in our examples. Parameters always starts with a lowercase. 

You have to create one parameter per component. Duplicated components are considered as a whole. 
For example, you have to create one parameter for the set of four legs. 

To create a parameter, proceed as follows: 

1. Click Add new parameter in the 
Parameters area. 

2. Click the parameter to display its 
properties. 

3. Replace the default name by one 
matching the naming convention, e.g. 
“box”. 

4. Select component in the Type drop-down 
list. The associated reference type is 
specified automatically. 

5. Changes are saved automatically. Click the 
cross icon to close the Parameter panel. 

 

 

 

For the “box and legs” sub-assembly of our sample cabinet, create the following parameters: 
“box” and “leg”. 

Link the Parameters with the Components 

The next step consists in linking each parameter to its component. 

1. Click the first parameter e.g. box to access its properties. 

2. Click Choose ref to select a product reference to link with the parameter. 

3. Search for the product using its 3DCloud name. Then, click the product thumbnail to add it as 
reference. 
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4. Repeat the proceeding to link the leg parameter with the leg product. 

Now the component reference appears after the name, in parentheses, 
instead of “null”. 

 

Create the Size Parameters 

Important: These size parameters are mandatory. 

The next step consists in creating the size parameters of the box that will be useful for the sub-assembly. 

1. Click Add new parameter in the Parameters area. 

2. Click the parameter default name to access its properties. 

3. Rename the parameter into width. 

4. Select number in the Type drop-down list. 

5. Enter a value, i.e. 600 for the box. 

6. Repeat the proceeding with the height (800) and the depth (600). 

The Parameters area now contains the following parameters: 

 

Link the Size Parameters to the Box 

This step consists in linking the size parameters with the dimensions of the components. 

 

The box must be linked dynamically to the size parameters to prepare the scaling of the base 
cabinet.  

Click the Box component in the list to consult its properties. Then, scroll down the panel to reach the 
Overloads field. The size parameters displayed in this area are recovered from the 3DCloud datasheet. 

1. Select the check box regarding the depth of the component to enable the modifications. 
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2. Move the cursor to Symbol to display the list of parameters declared in Assembly. 

3. Select the depth parameter. The depth parameter of the “Box” product is now overloaded by the 
depth parameter of the “box” component. 

 
Repeat the proceeding with the width and height of the box. The Overloads area now indicates that the 
three parameters have been overloaded. 

 

Define the Position of the Box in the Room 

Each component is placed relating to the absolute coordinate system (origin and axis). 

Click the box in the Components to display its properties. Go to the Position area to access the 
coordinates. 

 

 
Keep 0 in the X and Y fields and enter 80 in the Z field. This value corresponds to the height of the leg. The 
box is now 80 mm higher from the floor. 

Place the Legs 

To position the legs under the furniture you have to consider the following: 
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 The size of the box; 

 The positioning of the front legs on the box (may depend on whether the box will have a plinth or 
not); 

 The positioning of the back legs on the box (the distance may not be the same as for the front 
legs); 

Therefore, the position of the legs is managed through relations. 

 
In our sample case, there is no plinth and the distance is the same for all the legs.  

Create Leg Offset Parameters 

Before creating the relations, you have to create offset parameters to specify the position of each leg from 
the edge of the bottom of the bow. Then, these parameters will be used by the relations. 

 
Figure 10 – Leg offset 

As illustrated above, the offset is the distance between the center of a leg and the edge of the box. 

Note: Remember that our sample 3D objects are centered on the origin point. 

There are four legs, thus you have to define four offset parameters: 

 xFrontLegOffset: the offset of the front leg on the X-axis; 

 xBackLegOffset: the offset of the back leg on the X-axis; 

 yFrontLegOffset: the offset of the front leg on the Y-axis; 

 yBackLegOffset: the offset of the back leg on the Y-axis; 

 

To create these parameters, proceed as follows: 

1. Click Add new parameter in the Parameters area. 

2. Click the default name of the new parameter to display its properties. 

3. Replace the default name with xFrontLegOffset. 
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4. Select number in the Type drop-down list. 

5. Enter a value, e.g. 100 if you want the center of the leg to be place 100 mm from the left edge of 
the box. 

6. Repeat the proceeding to create the three other parameters for the three other legs. 

Now you have the following four leg parameters that you can use in relations. 

 

Create Offset Relations 

Note: Use the camel convention to rename relations; do not capitalize the first letter to avoid confusion 
with the components. 

To create the relations, you do not have to consider the sides (front / back) but the axes (X and Y). 
Remember that the offset parameters are defined on these axes. 

Thus, you will create four relations: 

 Two relations to place the leg on the X-axis 

 Two relations to place the leg on the Y-axis 

These relations will get a value calculated dynamically through a formula. This is important to ensure 
that the legs are aligned on a given axis. 

Click Create new relation on the left menu to start creating the relations. 

 
1. Select the default name of the relation to display its properties and start defining the relation. 

2. Change the default name with an appropriate one: xLeftLegsRelation. 

3. Select number in the Type drop-down list. 

4. Specify the Expression field with a formula referring to the main width parameter and specifying 
the distance in millimeters from the edge of the box: -width*0.5 + xFrontLegOffset. 

5. Press Enter to save the expression and update the Value field. 

 
Repeat the proceeding to create the second relation for the X-axis. 
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1. Name the relation xRightLegRelation. 

2. Enter width*0.5 – xBackLegOffset in the Expression field. 

 
Create now the relations on the Y-axis with the same proceeding. Note that the expression uses the depth 
parameter instead of the width, to be consistent with the Y-axis. Define them as follows: 

yBackLegsRelation 

Use yBackLegOffset in the expression: 

yFrontLegsRelation 

Use yFrontLegOffset in the expression: 

  

Define the Position of each Leg 

Now that the relations between the legs on a same axis and the box are created, you can specify the XYZ 
position of each feet from the floor. 

Click the BackLeftLeg component in the Components list to display its properties. Go to the Position area. 

Note: For the case you would define a fixed position for the legs, remember to take both the width of the 
box and the offsets into account. In addition, remember that the components should be distributed from 
the origin point. 

With the perspective of the future scalability of the cabinet, we will define dynamic positions of the legs, 
using the relations we have created previously. 

For our sample cabinet, which width and depth are 600 and 600 
respectively, enter the following: 

 X position: Move the cursor to Symbol and select the 
xLeftLegsRelation. 

 Y position: Move the cursor to Symbol and select the 
yBackLegsRelation. 

 Z position: Enter 0 (legs are on the floor). 
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The back left leg is now placed as illustrated below: 

 

 
Repeat the proceeding to place the three other legs and obtain the following result. 

 Back Left Leg Back Right Leg Front Left Leg Front Right Leg  

X position xLeftLegsRelation xRightLegsRelation xLeftLegsRelation xRightLegsRelation 

Y position yBackLegsRelation yBackLegsRelation yFrontLegsRelation yFrontLegsRelation 

Z position 0 0 0 0 

 

 

 

Prepare the Worktop 

The availability of the worktop is ensured by the combination of the worktop option and output sets. 
Should one of these be missing, the worktop could not be generated in the Kitchen Planner. 

Important: Do not add the worktop as material or component in Assembly Editor, this is useless. The 
worktop is added dynamically to the base cabinet in the Kitchen Planner only. See below “Step 7 – Display 
the cabinet in the Kitchen Planner”. 
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Worktop Option 

The worktop option is set in the top-assembly datasheet. 

 See “Step 6 / worktopOption” for the proceeding. 

About Output Sets 

An output set is a linear information required to place the worktop on the base cabinet. In the Kitchen 
Planner, output sets are used to define the 2D properties of the worktop (and plinths, wall panels, 
decorative strips, cornices paths as well). 

Output sets are of two types: 

 A polyline set, which is limited to lines defined by points only; 
 An edgeline set, which allow lines and circles defined by points and radiuses. 

 

 

 
To define the position of our worktop, we will use polyline sets. 

Create the Relations 

Polylines have either fixed coordinates, or variable coordinates using relations, in the perspective of a 
scaling. 

Place the starting point of the polyline, through a first relation. 

1. Click Create new relation. 

2. Click the default name to display the properties. 

3. Rename the relation into xPoint0NarrowPathPosition. 

4. Select number in the Type drop-down list. 

5. Go to the Expression field. 

6. Enter a formula referring to the width parameter width*0.5 as illustrated below. Press Enter to 
save the expression and update the Value field above. 

 
 

Then, place the destination point through a second relation named xPoint1NarrowPathPosition, which 
formula is -width*0.5. 
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Create the Output Set 

The points are created through the relations; you will now create the lines between these points and place 
them. 

Scroll down the left menu to Output Sets and click Add a polyline set to create the first output set. 

 

 
1. Click the default name to access the properties and rename it into narrowTopPath. “Top” means 

that this path concerns the top of the base cabinet; “narrow” means the front of the cabinet. 

2. Click Add a polyline to specify that you will draw a line. You cannot rename the polyline. 

 
3. Click Add a point to specify the start point of the line, and repeat this step to create the final point 

of the line. You cannot rename the points. 

4. Click the first Point (0, 0, 0) to access the coordinates of the start point. You could enter fixed 
coordinates but we will use the relations created previously.  

5. Move the cursor to the right of the X field to Symbol, to display the list of relations. 

6. Select xPointONarrowPosition in the list. 

7. Enter values in the Y and Z fields, because the scaling of the cabinet is limited to the X-axis: 

a. Enter -300 in the Y field, this value being the half of the depth of the box; 

b. Enter 880, in the Z field, this value being the total height of the cabinet (box and legs). 
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Do not worry if a line appears across the box. The second point is not defined yet. 

Click this second point and repeat steps 5 to 7 to define it with the following values: 

X field: The xPoint1NarrowPathPosition relation 

Y field: -300 

Z field: 880 

 
The first outline is now specified. 

Repeat the whole proceeding to define the second polyline. 

1. Scroll down the left menu to Output Sets and click Add a polyline set to create a second output 
set. 

2. Rename it into outerTopPath. “outer” means the back of the cabinet. 

3. Click Add a polyline. 

4. Click Add a point twice to add two points. You cannot rename the points. 

5. Click the first Point (0, 0, 0) and specify the following coordinates.  

 X field: select the xPoint0NarrowPathPosition relation 

 Y field: enter 300 (i.e. the half of the depth of the box) 

 Z field: enter 880 (i.e. the height of the box plus the legs) 

6. Click the second Point (0, 0, 0) and specify the following coordinates.  

 X field: select the xPoint1NarrowPathPosition relation 

 Y field: enter 300 again 

 Z field: enter 880 again 

The output sets are now defined as illustrated below. The box is ready to receive a worktop in the Kitchen 
Planner. 
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Save the Box and Legs Sub-Assembly 

Following the data model, (see above Data Model) the box and the legs must be saved as a sub-assembly. 
This is recommend to make it reusable and necessary to make them work as a group in further animations. 

Save the Work 

Click the Save my work icon on the up right corner to save the sub-assembly as a .BMA file. Assembly 
Editor produces a zip file containing a root.BMA file. Move the zip file to your project location and rename 
the file into box_leg.BMA. 

 

Create a Datasheet 

Then, create a product datasheet in 3DCloud for this sub-assembly. Import the .BMA file as 3D Model 
representation. 

You have to define in the 3DCloud datasheet all the parameters that are defined in Assembly. 

 

For our “box and legs” sub-assembly, this means that you have to create the size parameters 
(W600 / D600 / H800) and the offset parameters. 

 

Add the size parameters, then click Variable dimension again to add the offset parameters. 
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1. Click Create New and enter xFrontLegOffset. Press Enter to add it to the ID field. 

2. Specify the Display name field with the same. 

3. Select Discrete length (mm) to enter a value. 

4. Enter 100 in the Possible values field and as default value. 

5. Click Validate. 

6. Repeat the proceeding to create the xBackLegOffset, yFrontLegOffset and yBackLegOffset. 

 

 
 

Finally, add the new product to the catalog. 
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Whereby, you will be able to import it as a component in Assembly Editor to continue building the base 
cabinet. 

Create the “Front and Handle” Sub-Assembly 

Start from new to create the second sub-assembly. 

Add the Components 

1. Click Create new component on the left menu, or click Add a component on the scene. 

2. Browse the catalog by specifying the name of the product in the search field. Use either the 
complete name as defined in the 3DCloud datasheet or a term of the type e.g. “box” or “front”. 
Press Enter to start the search. 

 
3. Click the thumbnail of the product to add it to the list of components and display it on the scene. 

4. Repeat the proceeding to add the handle (i.e. the white knob). Now you have the following two 
components. 
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Remember that the components are centered by 
default on the origin of the axes. Their final 
position is not yet defined. 

 

 

Rename the Components 

Select a component in the list or on the scene to display its properties. 

Rename the door front component into DoorFront and the knob into Handle. 

Important: Always capitalize the first letters of the words in a compound name to avoid confusion with 
parameter names. 

 

Component Parameters 

Note: You create parameters as needed; this is not a batch process with the aim of creating all possible 
parameters just in case. 

Create the Component Parameters 

Important: Use camel case convention when renaming the parameters. 

You have to create one parameter per component.  

To create a parameter, proceed as follows: 

1. Click Add new parameter in the Parameters 
area. 

2. Click the parameter to display its properties. 

3. Replace the default name by one matching the 
naming convention. 

4. Select component in the Type drop-down list. 
The associated reference type is specified 
automatically. 

5. Changes are saved automatically. Click the 
cross icon to close the Parameter panel. 
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For the “front and handle” sub-assembly of our sample cabinet, create the following 
parameters: doorFront and handle. 

Link the Parameters with the Components 

The next step consists in linking each parameter to its component. 

1. Click the first parameter e.g. doorFront to access its properties. 

2. Click Choose ref to select a product reference to link with the parameter. 

3. Search for the product using its 3DCloud name. Then, click the product thumbnail to add it as 
reference. 

 
4. Repeat the proceeding to link the handle parameter with the handle product and get the 

following. Note that the component reference has replaced “null” in the parentheses. 

 

Size Parameters and Relations 

The next step consists in creating main size parameters identical to the size parameters of the whole 
cabinet. Relations will refer to these parameters to calculate the real dimensions of the door front 
dynamically. 

Important: These size parameters are mandatory. 

Main Size Parameters 

1. Click Add new parameter in the Parameters area. 

2. Click the parameter default name to access its properties. 

3. Rename the parameter into width. 

4. Select number in the Type drop-down list. 

5. Enter a value, i.e. 600 for the door front. 

6. Repeat the proceeding with the height (800) and the depth (600). 
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The Parameters area now contains the following parameters: 

 

Size Relations 

The “front and handle” sub-assembly will use relations to define dynamically some dimensions of the 
front and the handle. 

You have to create a relation to link the width of the door front to the main width parameter while 
considering its real size (remember that the width of the door front is set to 598 mm in its datasheet). 

Start creating the width relation for the front. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into frontWidth. 

4. Select Number as type. 

5. Enter width –2 in the Expression field and press Enter to update the Value field above. The width 
of the door front is now 598 mm. 

 
 

Continue by creating the depth relation. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into frontDepth. 

4. Select Number as type. 

5. Specify the Expression field with the following formula, where the dot means to get the value of 
the depth parameter for the DoorFront component: DoorFront.depth and press Enter to update 
the value. 
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Note: This type of expression cannot be “undefined” (i.e. =”null”). Do not forget to test the value. 

 

Finally, create a handle size relation. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into handleDepth. 

4. Select Number as type. 

5. Enter an expression relating to the handle component and the depth parameter: 
Handle.depth and press Enter to update the value. 

 

Link the Size Parameters to the Door Front 

This step consists in defining the size of the component using the size relations. 

The front width must vary while stretching the cabinet; front depth is defined dynamically for the case 
when the customer changes the door with one thicker or thinner, to ensure that the handle remains well 
placed. 

1. Click the DoorFront component in the list to access its properties. 

2. Scroll down to the Overloads field. The size parameters displayed in this area are recovered from 
the 3DCloud datasheet. 

3. Select the check box regarding the width of the component to enable the modifications. 

4. Move the cursor to Symbol to display the list of parameters declared in Assembly. 

5. Select the frontWidth relation. 

6. Select the depth check box, move the cursor to Symbol and select the frontDepth relation. 

Those calculated via the relation now overload the width and depth of the “DoorFront” component. 
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Repeat the proceeding with the depth of the handle. Select the Handle component and link it to the 
handleDepth relation. 

 

Front Position 

By default, the door is placed on the scene at the origin point like any component. Now we will place it on 
the front of the box. 

Create Position Relations 

The position of the front on the Z-axis must be calculated dynamically to follow the stretching of the whole 
cabinet. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into yFrontPosition. 

4. Select Number as type. 

5. Enter -depth*0.5 - frontDepth*0.5 in the Expression field. The formula is based on the half of the 
main depth and the half of the front depth. 

6. Press Enter to update the Value field above. The value is now -310. 

 

Door Front Position 

The final step consists in overloading the position of the door front component with the front position 
relation. 

1. Click the DoorFront component to access its properties. 

2. Go to Position and move the cursor to Symbol for the Y position. 



CREATE A BASE CABINET Tutorial Step 5 – Assemble the Products into a Cabinet  

3DVIA Documentation February 2020 - 77 - 

3. Select yFrontPosition in the list of relations. 

The door is now placed as illustrated below. Note that the handle is still on the default position. 

 
 

Opening Side Parameter 

The next step for this sub-assembly is to define a side parameter, as in the 3DCloud datasheet, to specify 
the opening side of the combination door front and handle.  

 
This parameter is in relation with the future animation of the base cabinet: opening the door. 

 

1. Click Add new parameter and click the default name to access the properties. 

2. Rename it into side. 

3. Select number (or integer) in the drop-down list. 

4. Enter -1 in the Value field because the door front is left opening (1 for a right opening door). 

5. Press Enter to validate the parameter. 

Note: To be valid, the side parameter must be used in two relations: the x-position of the handle and the 
rotation axis. See hereinafter. 

Handle Position 

The position of the handle must remain constant even if the door is stretched horizontally. The relation 
will be calculated from the main size parameters and offsets to specify the position from the edge of the 
front. 

 

For our sample cabinet we will use an offset of 160 mm from the top and side edges of the 
door to place the knob. 

Create Position Relations 

Start by creating the position on the X-axis. 

Note that this relation will use the side parameter that we have just created. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into xHandlePosition. 
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4. Select Number as type. 

5. Enter (width*0.5 - 160)*-side in the Expression field. 

6. Press Enter to update the Value field. 

 
Continue by creating the position on the Y-axis. The formula is based on the depth parameter, the depth 
of the front and the depth of the handle. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into yHandlePosition. 

4. Select Number as type. 

5. Enter -depth*0.5 - frontDepth - handleDepth*0.5 in the Expression field. 

6. Press Enter to update the Value field. 

 
 

Finally, create the position on the Z-axis. The formula calculates the position from the main height 
parameter, the height from the floor (the legs actually) and the offset. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into zHandlePosition. 

4. Select Number as type. 

5. Enter height + 80 -160 in the Expression field (where 80 is the height from the floor and 160 is 
the offset of the handle from the edge of the door front). 

6. Press Enter to update the Value field. 
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Handle Position 

Now that the position relations are defined, you have to overload the position of the handle with these 
relations. 

1. Click the Handle component to access its properties. 

2. Go to Position and move the cursor to Symbol for the X position. 

3. Select xHandlePosition in the list of relations. 

4. Overload the Y value with yHandlePosition and the Z value with zHandlePosition. 

The handle is now placed as illustrated below: 

  

Add an Animation 

Animations make it possible to define kinematic behaviors in the Kitchen Planner, such as opening the 
door of the base cabinet. 

Animations - either a rotation or a translation – apply to the components of an assembly as a whole. Thus, 
do not create the door animation at the top-assembly level because it would not be possible to rotate 
only the door front component within the whole assembly. Create the door front animation on the “front 
and handle” sub-assembly. 

The animation of opening a door is a rotation: the door front will rotate on the Z-axis. A translation would 
consist for example in opening a drawer from a cabinet on the Y-axis. 

Create a Relation 

To give the customer the possibility to change the direction of the door opening in the Kitchen Planner, 
you have to define the position of the rotation axis dynamically. 

1. Click Create new relation. 
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2. Select the default name to access its properties and rename it into xRotationAxisPosition. 

3. Enter the following formula in the Expression field, using the side and width parameters: 
side*width*0.5.  

4. Press Enter to update the value. 

 

Create the Rotation 

Scroll down the left menu to Animation and click Add a rotation. 

 
1. Click the rotation to display its properties. 

2. Specify the direction of the rotation: move the cursor to Symbol for the Z field and select the side 
parameter in the list. 

3. Specify the position of the rotation axis: 

a. Select Symbol for the axis x field and then, xRotationAxisPosition. 

b. Enter -300 (which is the half of the box depth) in the axis y field to place the rotation axis 
on the front. 

c. Leave the axis z blank. 

4. Keep the default value in the endAngle field. 
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Test the Animation 

Test the animation by clicking the Play icon either on the left menu or on the property panel. 

Also test the possibility of a right opening door by changing the value of the side parameter to 1 and 
clicking the Play icon. 

 

 

Save the Front and Handle Sub-Assembly 

Following the data model (see above Data Model) the door front and the handle must be saved as a sub-
assembly. This is recommend to make it reusable and necessary if you want to add an animation that will 
open the door front (handle and door front must work as a group). 

Save the Work 

Click the Save my work icon on the up right corner to save the sub-assembly as a .BMA file. Assembly 
Editor produces a zip file containing a root.BMA file. Move the zip file to your project location and rename 
the file into front_handle.BMA. 

 

Create a Datasheet 

Then, create a product datasheet in 3DCloud for this sub-assembly. Import the .BMA file as 3D Model 
representation. 

You have to define in the 3DCloud datasheet all the parameters that are defined in Assembly. 

Click Variable dimension to add the size parameters of the door front, as illustrated below: 

 
Then, add an option to specify the side opening of the door. Our door front is a left opening door. 

1. Click Create new and enter side in the text field. 
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2. Click the cross to add it to the ID field. 

3. Enter Side as display name. 

4. Select Discrete variation to enter a choice of values. 

5. Enter -1 and Left as first possible value. 

6. Enter 1 and Right as second possible value. 

7. Enter -1 as default value. 

8. Click Validate. 

 
Add a Product replacement option to create a choice of handles in the Kitchen Planner. 

1. Click Create new and enter handle in the text field. 

2. Click the cross to add it to the ID field. 

3. Enter Handle as display name. 

4. Select Allow empty value and Allow any value to open the choice to any existing handle in the 
catalog . 

5. Select the ceramic knob, i.e. white_round_knob01 as default product. 

6. Click Validate. 

 
Finally, add the new product to the catalog. 

 
Whereby, you will be able to import it as a component in Assembly Editor to continue building the base 
cabinet. 

Import the Sub-Assemblies as Components 

Now that both sub-assemblies are created and registered as products in 3DCloud, we can add them to a 
new assembly to be a part of the future top-assembly. 
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Create Components 

1. Click Create new component on the left menu, or click Add a component on the scene. 

2. Browse the catalog by specifying the name of the “box and legs” sub-assembly in the search field, 
i.e. box_leg01. Press Enter to start the search. 

 
3. Click the thumbnail of the product to add it to the list of components and display it on the scene. 

4. Repeat the proceeding to add the “front and handle” sub-assembly. Now you have the following 
two components. 

5. Rename the box_leg01 component into BoxWithLegs and the front_handle into 
FrontWithHandle. 

Important: Always capitalize the first letters of the words in a compound name to avoid confusion with 
parameter names. 

 

Component Parameters 

Important: Use camel case convention when renaming the parameters. 

You have to create one parameter per component, even if the component is a sub-assembly. 

 

Actually, the only important parameter in our case is “handle” because this is the only 
component that we want the customer to control (when replacing the default handle with 
another one in the Kitchen Planner). 

 

To create a parameter, proceed as follows: 

1. Click Add new parameter in the Parameters area. 

2. Click the parameter to display its properties. 

3. Change the default name into boxWithLegs. 

4. Select component in the Type drop-down list. The associated reference type is specified 
automatically. 

5. Click Choose Ref to select a product reference to link with the parameter. 
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6. Search for the product using its 3DCloud name. Then, click the product thumbnail to add it as 
reference. 

Changes are saved automatically. Repeat the proceeding to create a frontWithHandle parameter. 

You now have the following parameters. 

  

 

Size Parameters 

The next step consists in creating the size parameters for the sub-assemblies. Even if they have been 
specified at the creation, this is a new project and you need to specify the size parameters again. 

Create the Size Parameters 

1. Click Add new parameter in the Parameters area. 

2. Click the parameter default name to access its properties. 

3. Rename the parameter into width. 

4. Select number in the Type drop-down list. 

5. Enter a value, i.e. 600 that is the width of the future base cabinet, determined by the width of the 
box. 

6. Repeat the proceeding with the height (800) and the depth (600). The Parameters area now 
contains the following five parameters. 

 

Link the Size Parameters to the Door Front 

This step consists in linking the parameters of the product to those of the components. 

1. Click the BoxWithLegs component in the list to consult its properties. 
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2. Scroll down the panel to reach the Overloads field. The size parameters displayed in this area 
are recovered from the 3DCloud datasheet are displayed in a drop-down list. 

3. Select the check box regarding the depth of the component to enable the modifications. 

4. Move the cursor to Symbol to display the list of parameters declared in Assembly. 

5. Select the depth parameter. The depth parameter of the “box and legs” product is now linked to 
the depth parameter of the “BoxWithLegs” component. 

6. Repeat the proceeding with the width and height of the door front. The Overloads area now 
indicates that the Overload Editor contains three parameters. 

 
Repeat the proceeding with the FrontWithHandle component to overload the width of the component 
with the width parameter. Leave the other sizes as such. 

 

Both “box and legs” and “door front and handle” combinations must be linked dynamically to 
the width parameter to prepare the scaling of the base cabinet on the X-axis.  

Place the Shelf 

The next step consists in placing the shelf inside the box, centered vertically. Take the height of the box 
into account (800 mm) and the position of the box from the floor (80 mm). 

Start by creating a new component with the shelf of the catalog as resource, and rename it into Shelf. 

The shelf is placed by default on the bottom, as usually. 

 

Define the Position of the Shelf 

Define now the position of the shelf on the X, Y and Z axes. 

1. Select the Shelf component in the Components list to access its properties. 

2. Go to the Position fields. 
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3. Leave the X and Y position fields blank. 

4. Enter 480 in the Z position field, which is the half of the height of the box plus the height from the 
floor. 

The shelf is now placed in the box, as illustrated below: 

Tip: To view the shelf in the box, click the eye icon of the FrontWithHandle component to hide it. 

 

Shelf Width Relation 

To enable the scaling of the shelf with the whole cabinet, the width of the shelf must call a relation 
between its own size and the main width parameter. 

Note: Do not create specific width parameters because this would dissociate the shelf from the box when 
scaling it. 

Thus, you have to create a relation that will reduce the global width recovered from the width parameter 
to adapt it to the shell. 

1. Click Create new relation. 

2. Click the default name to display the properties of the relation. 

3. Rename the relation into shelfWidth. 

4. Select Number as type. 

5. Enter width–26  in the Expression field (without any space). This updates the Value field above: 
the width of the shelf is now 574 mm. 
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Link the Width of the Shelf to the Relation 

This step consists in overloading the default width parameter recovered from the datasheet with the value 
of the relation. 

1. Click the Shelf component in the list to consult its properties. 

2. Scroll down the panel to reach the Overloads field. 

3. Select the check box regarding the width of the component to enable the modifications. 

4. Move the cursor to Symbol to display the list of parameters declared in Assembly. 

5. Select the width parameter and move the cursor to Symbol. 

6. Select the shelfWidth relation in the drop-down list. 

7. Leave the other sizes as such. 

 

Test the Scaling 

We enabled a scaling in Geometry Editor to enlarge the base cabinet from 600 to 800 mm. In this 
perspective, we have also created relations at the sub-assembly levels to create dynamic dimensions and 
positions. 

The base cabinet is thus “scaling ready” and you can test it now. 

If you change the value of the width parameter, the base cabinet will increase proportionally. 

 

 

Create a Side Parameter 

The possibility of choosing the opening side of the door front implies to define a side parameter at the 
top-assembly level too. 
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Create the Parameter 

1. Click Add new parameter and click the default name to access the properties. 

2. Rename the parameter into side. 

3. Select number (or integer to be consistent with the side parameter of the door front) in the Type 
drop-down list. 

4. Enter -1 as value because the door front is by default left opening. 

Overload the Parameter 

The side value declared at the component level must be overloaded by the side parameter 

1. Select the FrontWithHandle component and go to the Overloads area. 

2. Check the box on the left of the side parameter. 

3. Move the cursor to Symbol. 

4. Select the side parameter in the drop-down list. 

 

Test the Opening 

Test the opening side of the door front by changing the value of the side parameter to 1. 

Handle Replacement 

Creating the possibility for the customer to choose between various handles for the same door is a long 
process that started with a handle parameter in the ‘”front and handle” sub-assembly. 

The action to perform at the top-assembly level is to create a handle parameter and to overload the 
component value with it. 

Note: The final step will be the creation of a product replacement option in the top-assembly datasheet. 

Handle Parameter 

Start by creating the handle parameter. 
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1. Click Add new parameter. 

2. Click the parameter to access its properties and rename it into handle. 

3. Select component in the Type drop-down list. 

4. Click Choose Ref to search for the product using its 3DCloud name, i.e. 
white_round_knob01 that is the default handle for this cabinet. 

5. Click the product thumbnail to add it as reference. 

 

Handle Component 

Continue by overloading the component. 

1. Go to Components and select 
FrontWithHandle to access its properties. 

2. Go to Overloads. 

3. Select the check box of the handle 
component. 

4. Move the cursor to Symbol. 

5. Select the handle parameter in the drop-
down list. 

 
Test the overload by changing the product referenced in the handle parameter. 

Save 

Click the Save my work icon on the up right corner to save the top-assembly as a .BMA file. 

Assembly Editor produces a zip file containing a root.BMA file. Move the zip file to your project location 
and rename the file into base_cabinet.BMA (which will replace the previous one). 

The base cabinet is now ready to be displayed in the Kitchen Planner. 
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Save the Top-Assembly 

Click the Save my work icon on the up right corner to save the top-assembly as a .BMA file. 

Assembly Editor produces a zip file containing a root.BMA file. Move the zip file to your project location 
and rename the file into base_cabinet.BMA. 
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STEP 6 – SAVE THE CABINET AS A PRODUCT  

To make the cabinet usable in other assemblies or visible in the Kitchen Planner, you have to create a 
product datasheet in 3DCloud for the top-assembly. 

Important: The 3D model in this datasheet is the base_cabinet.BMA file. 

Create a Base Cabinet Datasheet 

Click New Product in the Products list to create a datasheet. 

General Information 

 
1. Give a name to the product: select a language in the drop-down list and then, enter a name. 

Repeat this step for each language. This is an internal name; it will not be displayed to the 
customer. 

2. Define an internal reference for the product that will be used in Assembly Editor. This reference 
is different from the product reference displayed in the Kitchen Planner. 

3. Link the product to a product type, i.e. Base cabinets. 

4. Link the product to your Brand. 

Product Information 

 
1. Define a period of availability. These dates always overwrite the dates set in the catalog. 
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2. Choose a language to use in the Kitchen Planner. 

3. Enter the commercial description and a short description of the cabinet. 

4. Define tags to ease the classification of the base cabinet in the Kitchen Planner. 

Product Representation 

 
1. Click Upload a 3D model to search for the root.BMA file on your drive. 

2. Add a bitmap picture of the base cabinet by clicking Upload a picture. It will be used as thumbnail 
in the product list in 3DCloud and in the Kitchen Planner. 

Technical Information 

For our base cabinet, specify the following information. They will have an impact in the Kitchen Planner. 
Keep the default specifications for the other fields. 

 Target position: OnFloor 

 Height from floor: N/A 

 Manip mode: Rotate, Translate. 

The manipulation mode only applies to the whole product you will insert in the Kitchen Planner (i.e. a top-
assembly). Select the first two modes for the base cabinet. 

Variable Dimension 

This time, we will enable the Visible and Editable parameters when specifying the width and the options 
of the base cabinet in order to make them visible and editable in the Kitchen Planner. 
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1. Check the Visible and Editable options to allow the customer to edit the cabinet in the Kitchen 

Planner and choose between two possible sizes.  

2. Select width in the ID drop-down list (or create it if need be). 

3. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

4. Select Discrete length (mm) in the Type list to specify a choice of values. 

5. Enter 600 and Size A for the first possible value. 

6. Enter 800 and Size B as second possible value. 

7. Click Validate to save the variation. 

Fixed Dimensions 

Repeat the proceeding to specify the height and the depth of the base cabinet, but leave the first 
parameters disabled. 

  

worktopOption 

 See Appendix 2 for the list of possible parameters for a base cabinet. 

The worktopOption enables the customer to choose a worktop style that is generated by the Kitchen 
application automatically. 
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1. Check the Visible and Editable options to allow the customer to edit the worktop in the Kitchen 

Planner. 

2. Select worktopOption in the ID drop-down list (or create it if need be). 

3. Enter a label for the ID in the Display name field. Capitalize the first letter to avoid confusion with 
the ID. 

4. Select True / false in the Type list because it is a boolean. 

5. Enter True as default value. 

6. Click Validate to add the option. 

Opening Side 

Declare the opening side of the door front in the datasheet of the top-assembly too, because a side 
parameter has been defined in Assembly Editor. 

 
1. Click Add an option. 

2. Click Create new and enter side. Click the cross to validate the new ID. 

3. Enter Side in the Display name field. 

4. Select Discrete variation  in the Type drop-down list. 

5. Enter -1 and Left as first possible value. 

6. Enter 1 and Right as second possible value. 

7. Enter -1 as default value. 

8. Enable the Visible and Editable parameters on the top of the screen. 
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9. Click Validate to save the option. 

 

Now, the parameters and options are the following: 

 

Product Replacement 

Add a Product replacement option to create a choice of handles in the Kitchen Planner. 

 
1. Enable the Visible and Editable option to allow the customer choose another handle in the 

Kitchen Planner. 

2. Click Create new and enter handle in the text field. 

3. Click the cross to add it to the ID field. 

4. Enter Handle as display name. 

5. Click Add products to open the list of all the products available in the database. 

6. Enter the exact name of the first product in the search field, or use a generic word followed by an 
asterisk to reduce the list. 
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7. Select our three handles, i.e. white_round_knob01, metal_round_knob01 and metal_handle02. 

8. Click Validate. 

9. Select white_round_knob01 as default product. 

10. Click Validate. 

 

You can define a product replacement for the front too, if at least one other front datasheet already exists 
in 3DCloud or if you want to prepare this possibility. In this case, select the black molded door both as 
possible and as default product; you may add more products later. 

The base cabinet now has the following replacement possibilities: 

 

Save 

Click Save to upload the model and its datasheet in the 3DCloud storage. Click Products to see the new 
product in the list. 

When the product is successfully added, the 3D model column displays Yes in the product list. 

Add the Base Cabinet to a Catalog 

To make the base cabinet usable in Assembly Editor, you have to link it to a catalog. 

1. Click the Products catalogs tab and search for your catalog. 

2. Click Add products to open the list of all available products. 

3. Select the base cabinet in the list. 

 
4. Scroll down and click Validate to add the product to the catalog. 
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The base cabinet is now listed in the catalog with the other products. 

 
And it is listed with the other products, with the good catalog reference: 
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STEP 7 – DISPLAY THE CABINET IN THE KITCHEN PLANNER  

The final step is to display the base cabinet in the Kitchen Planner. This relies on a link between the catalog 
where the base cabinet is listed as product, and an application distribution. 

There are three main types of kitchen application distributions: 

 A type dedicated to Assembly Editor 

 A type dedicated to the Template Editor 

 A type dedicated to the Kitchen Planner 

We will choose the third type to display our base cabinet. 

Process in 3DCloud 

The process starts in 3DCloud. 

1. Open the catalog in which the base cabinet is listed. 

2. Select a Kitchen type application distribution in the drop-down list. 

3. Click Save. 

The base cabinet is now linked to the appropriate application distribution. 

Insert in the Kitchen Planner 

Connect to the Kitchen Planner and follow the process below: 

1. Click the Design your kitchen tab. 

2. Click the Search icon. 

3. Enter the name of your base cabinet in the search field. 

4. Press Enter to start the search. 

 
5. Click the thumbnail to add the base cabinet to the kitchen. 

The cabinet is placed in a room and the worktop has been generated, as illustrated below: 
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Test the Behavior in the Kitchen Planner 

Click the base cabinet in the room to display the following Edition menu. 

 
Note that this menu displays information recovered from the 3DCloud datasheet: the name and the short 
description. 

It also contains an Edit icon to make some modifications on the cabinet, and an Open icon to play the 
door animation. 

Via the Edit icon, you can test the following customizations that we have prepared on the base cabinet: 

 The replacement of the handle 

 The replacement of the worktop 

 A choice between two door opening side 

 A choice between two widths 

 

 

Replace the Handle 

Click the Edit icon to edit the replacement of the handle. 
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1. Click Replace to access the list of possible handle. 

2. Click the thumbnail of the wished one, for example the 
metal handle. 

3. Choose Apply to the selected linear. The base cabinet 
has a new handle. 

4. Click Back to return to the change options. 

 

 
 

Replace the Worktop 

Click the Edit icon to edit the replacement of the worktop. 

5. Click Replace to access the list of possible worktops. 

6. Click the thumbnail of the wished one, for example a grey worktop. 

7. Choose Apply to the selected linear. The base cabinet has a new worktop. 

8. Click Back to return to the change options. 

Change the Width 

This option has been long prepared since Geometry Editor. It is now the time when you can test it. 

Select 800 in the Width drop-down list to see the cabinet enlarge to 800 mm. 

Door Opening Side and Animation 

Select 1 in the Side drop-down list to change the opening side to the right. 

Click the Open icon to play the kinematic and see the door opening. 

The base cabinet now looks different: 
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CONCLUSION 

Creating a base cabinet is long process through four applications: a 3D modelling software, Geometry 
Editor, 3DCloud and Assembly Editor, with many back and forth between 3DCloud and Assembly Editor; 
and finally you arrive to the Kitchen Planner. 

 

This process should be done with the constant perspective of the result displayed to the customer in the 
Kitchen Planner. It recovers so much from 3DCloud and from Assembly Editor. 

Each time you write a description or a display name, you write something that will be displayed to the 
customer. 

Each time you opt for a continuous length or variation, you opt for a value field in the Kitchen Planner. 

Each time you opt for a discrete length or variation, you opt for a list of choices in the Kitchen Planner. 

When creating labels and parameters, remember that capitalization matters. 

 

More difficult is to work with the perspective of the relations within the whole process. Remember that 
each parameter in Assembly Editor must have its duplicate in 3DCloud and vice versa. 

Keep the data model in mind when creating the pyramid of components that will result in the top-
assembly. Moreover, do not define parameters that are not required at this stage of the data model. 
Remember that the dimension parameters are the only parameters that are mandatory for every product 
in 3DCloud, whether it is a single product, a sub-assembly or a top-assembly. Other parameters have 
specific intentions, either depending on the level of assembly, or on the expected result in the Kitchen 
Planner. 

 

We hope that you will use this sample cabinet to try different combinations and go further with our ByMe 
applications! 
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APPENDIX 1 – CHECK-LIST 

Product Level 

Object Application Type Name Check 

BOX 3DCloud Dimensions width (600) 

height (800) 

depth (600) 

 

LEG 3DCloud Dimensions width (40) 

height (80) 

depth (70) 

 

SHELF 3DCloud Dimensions width (574) 

height (19) 

depth (575) 

 

DOOR FRONT 3DCloud Dimensions width (598) 

height (798) 

depth (20) 

 

Option type (1)  

HANDLE 

(handle / knob) 

3DCloud Dimensions width (128 / 30) 

height (20 / 30) 

depth (30 / 30) 

 

Option type (1)  

WORKTOP 3DCloud Dimensions width (65) 

height (40) 

depth (65) 

 

Option worktopType 
(precut) 
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Sub-Assembly Level - Box and Legs 

Application Type Name Check 

3DCloud Dimensions width 

height 

depth 

xBackLegOffset 

yBackLegOffset 

xFrontLegOffset 

yFrontLegOffset 

 

Assembly Editor Components Box 

BackLeftLeg 

BackRightLeg 

FrontLeftLeg 

FrontRightLeg 

 

Component parameter baseBox 

leg 

 

Size parameter width (600) 

height (800) 

depth (600) 

xBackLegOffset (100) 

yBackLegOffset (100) 

xFrontLegOffset (100) 

yFrontLegOffset (100) 

 

Relations xLeftLegsRelation (-200) 

xRightLegsRelation (200) 

yBackLegsRelation (200) 

yFrontLegsRelation (-200) 

xPoint0NarrowPathPosition (300) 

xPoint1NarrowPathPosition (-300) 

 

Output sets narrowTopPath (Polylines) 

Point (300, -300, 880) 

Point (-300, -300, 880) 

outerTopPath (Polylines) 
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Point (300, 300, 880) 

Point (-300, 300, 880) 

 

 

Sub-Assembly Level – Front and Handle 

Application Type Name Check 

3DCloud Dimensions width 

height 

depth 

 

 Option side (1 / -1)  

Assembly Editor Components DoorFront 

WhiteKnob 

 

 Component parameter doorFront 

handle 

 

 Size parameter width (600) 

height (800) 

depth (600) 

 

 Option parameter side (1 / -1)  

 Relations frontWidth (597) 

frontDepth (20) 

handleDepth (30) 

yFrontPosition (-310) 

xHandlePosition (140) 

yHandlePosition (-335) 

zHandleRelation (720) 

xRotationAxisPosition (-300) 

 

 Animation Rotation  
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Top-Assembly Level - Base Cabinet 

Application Type Name Check 

3DCloud Dimensions width 

height 

depth 

 

 Option side (1 / -1) 

worktopOption 

(true / false) 

 

 Product replacement handle 

front 

 

Assembly Editor Components BoxWithLegs 

FrontWithHandle 

Shelf 

 

 Component parameter boxWithLegs 

frontWithHandle 

handle 

front 

 

 Size parameter width (600) 

height (800) 

depth (600) 

 

 Option parameter side (1 / -1)  

 Relations shelfWidth (574) 

frontWidth (597) 

frontDepth (600) 
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APPENDIX 2 - BASE CABINET PARAMETERS 

Important: Possible values in a range are formatted hereinafter as [0; ;∞]. However, never enter 0 as 
minimum value nor an infinite value as maximum value. 

General Parameters for any Product or Assembly 

Name Type Status Default Value Possible 
Values 

Description 

depth real mandatory - [0 ; ∞] Defines the size of the model on the Y-axis. 

width real mandatory - [0 ; ∞] Defines the size of the model on the X-axis. 

height real mandatory - [0 ; ∞] Defines the size of the model on the Z-axis. 

Specific Product Parameters 

Name Type Status Default 
Value 

Possible 
Values 

Description 

box product recommended - - Dedicated parameter for client 
Range integration 

damper product mandatory - - Dedicated parameter for client 
Range integration 

front product mandatory - - Dedicated parameter for client 
Range integration 

handle product recommended - - Dedicated parameter for client 
Range integration 

hinge product mandatory - - Dedicated parameter for client 
Range integration 

leg product recommended - - Dedicated parameter for client 
Range integration 

shelf product recommended - - Dedicated parameter for client 
Range integration 
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type 

(in case of doors) 

integer recommended 1 1 or 2 Specifies whether the door is a 
standard one or has an integrated 
handle. 

type 

(in case of 
handles) 

integer recommended 1 1/2/3 Specifies the position of the handle 
on the front. 

worktopThick real recommended - [0 ;∞] Enables the Range Manager to use 
the thickness of the worktop to 
calculate the position of other 
products in the cabinet assembly 
(e.g. sinks or cooktops). 

worktopThickness string mandatory - - Defines the size of the worktop. Also 
used to filter products in the Kitchen 
Planner. 

worktopType string mandatory - Precut / 
custom 

Defines the type of worktop, also 
used as filter in the Kitchen Planner. 

Sub-Assembly Parameters 

Box & Legs Sub-Assembly 

Name Type Status Default 
Value 

Possible 
Values 

Description 

boxAssembly product recommended - - Dedicated parameter for client Range 
integration on assembly level. 

legHeight real recommended - - Dedicated parameter for client Range 
integration to change the height of the leg. 
This will change the vertical position of the 
box at the same time. 

rightLegOption integer mandatory 1 0/1/2 Allows BR to enable, disable or move legs 
to ensure the right number of legs in a 
linear combination of cabinets. 

leftLegOption integer mandatory 1 1/2/3/4 Allows BR to enable, disable or move legs 
to ensure the right number of legs in a 
linear combination of cabinets. 
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Front & Handle Sub-Assembly 

Name Type Status Default 
Value 

Possible 
Values 

Description 

doorAssembly product recommended - - Dedicated parameter for client 
Range integration at assembly level. 

side real 
integer 

recommended -1 -1 (Left); 
1(Right) 

Enables the customer to change the 
door opening side of the cabinet, 
which will change the position of the 
handle at the same time. 

handleLayout integer recommended 1 0/1 Enables the customer to force 
centered handle position instead of 
right and left position managed by 
side parameter. 

handleOrientation integer recommended 1 0/1 Enables the customer to change the 
orientation of the handle (available 
only if handleLayout is set to 1). 
0 corresponds to horizontal and 1 to 
vertical. 

function string mandatory - - Contains commercial functional 
description for filtering in the 
catalog browser (e.g. “door & 
drawer”). Requires using parameter 
display fields for translations. 

Drawer Sub-Assembly 

Name Type Status Default 
Value 

Possible 
Values 

Description 

drawer product recommended - - Dedicated parameter for client Range 
integration on assembly level. 

function string mandatory - - Contains commercial functional 
description for filtering in the catalog 
browser (e.g. “door & drawer”). 
Requires using parameter display fields 
for translations. 
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drawerLight product recommended - - Dedicated parameter for client Range 
integration. 

drawerFront product recommended - - Dedicated parameter for client Range 
integration. 

internDrawer product recommended - - Dedicated parameter for client Range 
integration on assembly level. 

Top-Assembly Parameters 

Dimension Parameters 

Name Type Status Default 
Value 

Possible 
Values 

Description 

commercialDimens
ions 

string mandatory - - Description of the dimensions 
to display in the Kitchen 
Planner (e.g. "W400 x D600 x 
H880"). Use parameter display 
fields for translation. 

commercialWidth integer mandatory - - Specifies a commercial width 
used as a filter to browse the 
catalog in the Kitchen Planner 
(e.g." 40 cm"). Use parameter 
display fields for translation. 

commercialDepth integer mandatory - - Specifies a commercial depth 
used as a filter to browse the 
catalog in the Kitchen Planner 
(e.g." 60 cm"). Use parameter 
display fields for translation. 

Worktop Parameters 

Name Type Status Default 
Value 

Possible 
Values 

Description 

worktopOption boolean mandatory TRUE TRUE / 
FALSE 

Enables the customer to 
choose a worktop that is 
automatically generated by 
the Kitchen application 
(requires paths defined in 
the BMA). 



CREATE A BASE CABINET Tutorial Appendix 2 - Base Cabinet Parameters  

3DVIA Documentation February 2020 - 110 - 

Cover Panel Parameters 

Name Type Status Default 
Value 

Possible 
Values 

Description 

coverPanelDepth real mandatory 13 [0 ;∞] Defines the thickness of the 
cover panels, for cover 
panel building and cabinet 
placing. 

backCoverPanel product mandatory - - Dedicated parameter for 
client Range integration, 
when a cabinet is not placed 
against the wall. 

backCoverOption boolean mandatory FALSE TRUE / 
FALSE 

Allows the BR to enable the 
backside panel of a cabinet, 
if backCoverPanel [product] 
is set. 

rightCoverPanel product mandatory - - Dedicated parameter for 
client Range integration, 
when a cabinet is not placed 
against the wall. 

rightCoverOption* boolean mandatory FALSE TRUE / 
FALSE 

Allows BR to enable the 
right side panel of a cabinet, 
if rightCoverPanel [product] 
is set. 

zRightCoverPositio
n 

real recommend
ed 

- - Enables the Range Manager 
to define the position where 
the right cover panel starts 
from the floor (on the Z-
axis), if rightCoverPanel 
[product] is set. 

leftCoverPanel product mandatory - - Dedicated parameter for 
client Range integration, 
when a cabinet is not placed 
against the wall. 

leftCoverOption* boolean mandatory FALSE TRUE / 
FALSE 

Allows the BR to enable the 
left side panel of a cabinet, 
if leftCoverPanel [product] is 
set. 
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zLeftCoverPosition real recommend
ed 

- - Enables the Range Manager 
to define the position where 
the left cover panel starts 
from the floor (on the Z-
axis), if leftCoverPanel 
[product] is set. 

Wall Panel Parameters 

Name Type Status Default 
Value 

Possible 
Values 

Description 

wallPanelOption boolean mandatory FALSE TRUE / 
FALSE 

Allows the customer to 
enable and choose a wall 
panel (based on 'WallPanel' 
type). 

wallPanelType boolean mandatory - Precut / 
custom 

Defines the type of wall 
panel, also used as filter in 
the Kitchen Planner. 

allowWallPanelAut
oCompletion 

boolean mandatory TRUE TRUE Allows BR to automatically 
set wall panel option to a 
cabinet, if this cabinet is 
added to a linear where a 
wall panel is already set 
(requires wallPanelOption 
[boolean]). 

Other Linear Parameters 

Name Type Status Default 
Value 

Possible 
Values 

Description 

type 

(in case of plinths) 

string recommended  OnFront / 
OnFrame / 

OnLeg 

Specifies the position of the 
plinth on the cabinet. 

plinthOption boolean mandatory TRUE TRUE / FALSE Allows the customer to add a 
plinth (based on 'Plinth' type). 

wallEdgeStripOption boolean mandatory FALSE TRUE / FALSE Allows the customer to add a 
wall edge strip (based on 
'WallEdgeSrip' type). 
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railOption product recommended - - Allows the customer to add and 
define a suspension rail 
product. 

sinkCutOutEdge product optional - External dbID Allows cut out edges on the 
sink base cabinet. 
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APPENDIX 3 – ADVANCED INFORMATION 

Select the Good Software / Format Combination 

Below is the list of all possible 3D modelling software, from the most compatible to the lowest. 

Software Export format Support information 

Solidworks 
2018 

Native 3DCloud Solidworks plug-in 

3dsmax 2016 
x64 

 

DAE OpenCollada Qualified using http://www.opencollada.org 
v1.4.1 

GLB / GLTF 
version 2.0 

Compatible  using 
https://doc.babylonjs.com/resources/3dsmax_to_gltf 

Blender 2.79b DAE OpenCollada Compatible 
v1.4.1 

OBJ + MTL Compatible 
Any version 

GLB / GLTF 
version 2.0 

Compatible using 
https://doc.babylonjs.com/resources/blender_to_gltf 

As .glb or .gltf + .bin + textures. Self embedded GLTFs are not 
supported. 

Maya 2019 GLB / GLTF 
version 2.0 

Compatible using 
https://doc.babylonjs.com/resources/maya 

As .glb or .gltf + .bin + textures. Self embedded GLTFs are not 
supported. 

Sketchup  Not supported 

AutoCAD  Not supported 

Analyze the Supported Features 

OBJ Format 

Meshes & Primitives 
Features 

Support 

3 points faces  Full  

4 points faces  Partial 
Caution: The conversion process might alter concave polygons. 
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>4 points faces  None 

Color/Dissolve 
interpolation 

 None 

Free forms  None 

Groups  Full 

Level of details  Ignored 

Lines  None 

Normals  Full 

Points  None 

Shadow and Ray 
casting 

 Ignored 

The Kitchen planner already computes shadows and reflections. 
They cannot be forced by the models data. 

Smoothing groups  None 

Texture coordinates  Full 

Vertex  Full 

GLTF / GLB Formats 

Meshes & Primitives 
Features 

Support 

Joints  None 

Lines  None 

Line loops  None 

Line strips  None 

Normals  Full 

Points  None 

Positions  Full 

Tangents  None 

Texture coordinates  Partial 
Caution: Only TEXTCOORD_0 and TEXTCOORD_1 are taken into 
account. 
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All material textures are applied to the texture coordinates of index 
0. 
The texture coordinates of index 1 can additionally reference the 
occlusion map. 

Triangles  Full 

Triangle fans  Full 

Triangle strips  Full 

Vertex colors  None 

Weights  None 

DAE (OpenCollada) 

Geometries Features Support 

Basic meshes  Full 

Convex meshes  None 

Splines  None 

Basic vertices  Full 

Control vertices  None 

Material Binding  Partial 
Only the "technique_common" tag is taken into account. 

 

Primitives Features Support 

Lines  None 

Linestrips  None 

Polygons  Partial 

Caution: The conversion process might alter concave polygons. 

Polylist  Full 

Triangles  Full 
Supported inputs are VERTEX, NORMAL and TEXTCOORD 

Trifans  None 
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